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Anmerkung für Macintosh Nutzer

Einige Tastenbelegungen (Tastenkürzel) und Menüeinträge unterscheiden sich zwischen der 
Macintosh Version und denen für Windows- und Linux-Rechnern. Die unten stehende Tabelle gibt 
Ihnen einige grundlegende Hinweise dazu. Eine ausführlichere Aufstellung dazu finden Sie in der 
Hilfedatei des jeweiligen Moduls.

Windows/Linux entspricht am Mac Effekt

Menü-Auswahl Extras → 
Optionen

LibreOffice → Einstellungen Zugriff auf die Programmoptionen

Rechts-Klick Control+Klick Öffnen eines Kontextmenüs

Ctrl (Control)

oder Strg (Steuerung)

⌘ (Command) Tastenkürzel in Verbindung mit anderen 
Tasten
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Was ist Draw?

Draw ist ein Vektorgrafik-Zeichenprogramm, enthält aber auch einzelne Funktionen für Raster- 
oder Pixelgrafiken. Mit Hilfe von Draw können Sie Bilder und Grafiken erzeugen.

Vektorgrafiken behandeln Bilder als Kombinationen geometrischer Elemente (wie Linien, Kreise 
und Vielecke) und nicht als Pixelmenge (Pixel sind einzelne Bildpunkte). Daher können Vektor-
grafiken sehr einfach und verlustfrei vergrößert oder verkleinert werden.

Draw ist vollständig in das LibreOffice-Programmpaket integriert, sodass mit Draw erstellte Grafi-
ken in allen Komponenten von LibreOffice problemlos eingefügt werden können. So kann zum 
Beispiel ein in Draw erstelltes Bild einfach durch Kopieren und Einfügen in ein Writer-Textdoku-
ment eingebettet werden. Innerhalb von Impress oder Writer steht ein Teil der Grafikfunktionen von
Draw zur Verfügung – auch ohne dass Draw dazu extra gestartet werden muss.

Draw besitzt eine weitreichende Funktionalität. Obwohl es nicht als hochspezialisiertes Zeichen-
programm konzipiert wurde, kann man damit doch häufig mehr erreichen als mit den Zeichenpro-
grammen anderer Bürosoftware.

Einige der Zeichenfunktionen seien beispielhaft aufgezählt:

• Ebenenverwaltung

• „Magnetische“ Fangpunkte

• Dimensions- und Maßstabsanzeige

• Verbinder für Organigramme

• 3D-Funktionen zur Erstellung kleiner 3D-Grafiken (mit Textur- und Lichteffekten)

• Integration von Formatvorlagen

• Bézierkurven

In diesem Kapitel erhalten Sie einen Überblick über grundlegende Funktionen von Draw, ohne 
Vollständigkeit anzustreben. Wenn Sie mehr erfahren möchten, lesen Sie bitte im Draw-Handbuch 
oder der Hilfe nach.

Das Draw-Fenster

Die Bestandteile des Draw-Fensters zeigt Abbildung 1. Der besseren Lesbarkeit halber sind der 
Arbeitsbereich und die Farbleiste stark verkleinert worden. Je nach den bei Ihnen gültigen Ein-
stellungen werden eventuell auch manche Symbolleisten nicht oder andere angezeigt.

Allgemeine Informationen zu Menüs, Symbol-, Seiten- und Statusleiste finden Sie im Kapitel 
„Einführung in LibreOffice“ dieses Handbuchs; wir werden daher hier auf diese Themen nur kurz 
eingehen. Die bei Ihnen angezeigten Leisten können von der Abbildung abweichen, Sie können 
das aber wie dort beschrieben einstellen.

Seiten- und Farbleiste wie auch der Folienbereich können, wenn Sie den Platz für den Arbeits-
bereich temporär vergrößern wollen, schnell durch einen Klick auf die schmale graue Schaltfläche 
mit dem Dreieck am Rand der jeweiligen Leiste aus- und wieder eingeblendet werden.

Folienbereich
Ein Draw-Dokument kann mehrere Seiten umfassen, in denen Sie thematisch zusammengehörige 
Zeichnungen in einem Dokument zusammenfassen. Im Folienbereich sehen Sie alle Seiten Ihres 
Dokuments und können die zu bearbeitende auswählen. Sollte der Folienbereich nicht sichtbar 
sein, können Sie ihn über Ansicht → Folienbereich anzeigen.
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Abbildung 1: Draw-Fenster nach dem Einfügen eines Rechtecks

Arbeitsbereich
Der Arbeitsbereich im Zentrum des Fensters dient dazu, ihre Zeichnung zu erstellen. Wie Sie dazu 
vorgehen, sehen sie in „Zeichnen von Grundformen“ auf Seite 9.

Eine Zeichnung in Draw kann maximal 300 mal 300 cm groß sein.

Lineale
Die Lineale oben und zur Linken des Arbeitsbereichs zeigen die Größe des ausgewählten Objekts 
an. Ist kein Objekt ausgewählt, zeigen sie die Position bzw. Koordinaten des Mauszeigers an, um 
die genaue Positionierung von Zeichenobjekten zu erleichtern. Sie können sie über Ansicht → 
Lineale an- und abschalten.

Auch die Seitenränder werden auf den Linealen angezeigt, und Sie können Sie dort mit der Maus 
verschieben.

Ebenen
Ein Zeichnungsdokument kann mehrere Ebenen haben, auf denen Sie ihre Zeichnungsobjekte 
platzieren können. Die Ebenen können Sie bei Bedarf für die Anzeige oder den Druck ein- und 
ausblenden, um z.B. Maßlinien oder einen „Hintergrund“ auszublenden und so das Bild 
überschaubarer zu machen, oder Sie können sie schützen, damit Sie die Objekte nicht aus 
Versehen verändern. Über Einfügen → Ebene… oder das Kontextmenü der Ebenen-Leiste 
können sie Ebenen einfügen oder ändern, Näheres finden Sie im Draw-Handbuch.

Standardmäßig sind drei Ebenen vorhanden:
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• Layout: für alle Zeichnungsobjekte. Weitere Ebenen, die Sie einfügen, verhalten sich 
genauso wie diese.

• Steuerelemente: hier werden automatisch die Steuerelemente platziert, die Sie in die 
Zeichnung einfügen. Diese Ebene zeichnet sich dadurch aus, dass ihre Element immer 
ganz vorne liegen, unabhängig von der Reihenfolge ihres Einfügens in die Zeichnung, so 
dass die Steuerelemente wie z.B. Schaltflächen immer zugänglich sind.

• Maßlinien: Maßlinien, die die Größen eines Objekts anzeigen, können so leicht 
ausgeblendet werden.

Hinweis

Die Ebenen (mit Ausnahme der Ebene Steuerelemente), auf denen sich die Zeich-
nungsobjekte befinden, bestimmen nicht deren Anordnung, also die Festlegung, wel-
ches Objekt das andere teilweise überdeckt, wenn sich ihre Flächen überschneiden.
Diese wird vielmehr zunächst durch die Reihenfolge bestimmt, in der sie die Objekte
hinzufügen: die zuletzt hinzugefügten liegen vorne.
Die Reihenfolge können Sie dann aber über Ändern → Anordnung oder 
Kontextmenü → Anordnung verändern.

Die Seitenleiste
Die Seitenleiste ist in ihrem Teilbereich Eigenschaften, der standardmäßig angezeigt wird, (die 
Teilbereiche wählt man über die Symbole am rechten Rand), eine sich dynamisch an das aktive 
Objekt anpassende Kombination der wichtigsten Funktionen aus Menüs, Symbolleisten und 
Dialogen. Außerdem ermöglichen die anderen Teilbereiche noch den Zugriff auf Formen, 
Formatvorlagen, Galerie und Navigator.

Näheres zur Seitenleiste finden Sie im Kapitel 1 „Einführung in LibreOffice“ dieses Handbuchs.

Farbleiste
Die Farbleiste ermöglicht eine schnelle Auswahl der gewünschten Farbe aus der angebotenen 
Palette. Sie können die Palette anpassen über das Menü: Format → Fläche… → Farben. Der 
zugehörige Dialog wird auch in den Optionen von LibreOffice benutzt und wird in Kapitel 2 
„LibreOffice Einstellungen“ näher beschrieben.

Wählen Sie eine Form aus und klicken Sie dann mit der linken Maustaste auf die Farbe, um diese 
der Fläche, mit der rechten, um sie der Linie zuzuweisen. Bei einem Text wählen Sie den Text aus 
und weisen dann die Farbe wiederum mit der linken Maustaste zu.

Die Symbolleiste Zeichnung
Diese Symbolleiste ist in Draw die bedeutendste. Sie ist standardmäßig an der linken Seite 
angedockt und enthält die Funktionen, die Sie zum Einfügen von geometrischen und anderen 
Objekten und zum Teil auch ihrer Formatierung benötigen. Wir werden sie in vor allem in 
„Zeichnen von Grundformen“ auf Seite 9 verwenden.

Weitere Symbolleisten
Weitere Symbolleisten können sie über den Menüpunkt Ansicht → Symbolleisten einblenden. 
Die bereits geöffneten Symbolleisten sind durch einen Haken vor dem Namen gekennzeichnet.
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Zeichnen von Grundformen

Draw bietet in der Symbolleiste Zeichnung eine große Anzahl an Formen, wobei verwandte For-
men in Paletten zusammengefasst sind, die über ein gemeinsames Symbol geöffnet werden; Sie 
erkennen das an einem kleinen Dreieck rechts vom Symbol. In der Symbolleiste wird das zuletzt 
ausgewählte Symbol aus der Palette angezeigt. Dieser Abschnitt beschreibt lediglich einige wenige
Grundformen. Im Draw-Handbuch finden Sie eine komplette Beschreibung der vorhandenen 
Formen.

Hinweis
Wenn Sie eine Grundform zeichnen oder ein Objekt zur Bearbeitung auswählen, 
zeigt dies das Informationsfeld auf der linken Seite der Statusleiste an,z. B. 
„Erzeuge Linie“ (mitsamt deren Abmessungen), „Textrahmen ‚xxyy‘ ausgewählt“ usw.

Eine gerade Linie zeichnen

Klicken Sie auf das Symbol Linie  in der Symbolleiste Zeichnung oder im Teilbereich Formen der
Seitenleiste und positionieren Sie den Mauszeiger an der Stelle, wo die Linie beginnen soll. 
Bewegen Sie die Maus mit gedrückter linker Maustaste. Lassen Sie die Maustaste los, wenn Sie 
die Stelle des Linienendpunktes erreicht haben.

Eine Auswahlmarkierung erscheint an jedem Ende der Linie. Diese zeigt an, dass die Linie das 
momentan ausgewählte Objekt ist (Abbildung 2).

Abbildung 2: Zeichnen einer Linie

Um den Winkel der Linie auf ein Vielfaches von 45° (0°, 45°, 90°, 135° usw.) zu begrenzen, halten 
Sie die Umschalt-Taste gedrückt, während Sie die Linie zeichnen.

Um den Endpunkt der Linie am nächsten Rasterpunkt zu fangen, halten Sie die Strg-Taste 
gedrückt, während Sie die Linie zeichnen. Mehr dazu im Abschnitt „Fangfunktionen“ auf Seite 18.

Um die Linie symmetrisch in beide Richtungen, ausgehend vom Startpunkt zu erweitern, halten Sie
die Alt-Taste gedrückt, während Sie die Linie zeichnen.

Um die Attribute der Linie (wie z. B. Farbe oder Linientyp) zu ändern, wählen Sie die Linie aus, in-
dem Sie darauf klicken, und dann eine der folgenden Möglichkeiten: die Seitenleiste (der direkteste
Weg), den Menüpunkt Format mit seinen Untermenüs (mit der vollständigsten Auswahl), das 
Kontextmenü (rechte Maustaste), für Farben zusätzlich auch die Farbleiste und die Symbole 
Linienfarbe und Füllung der Symbolleiste Zeichnung.

Einen Pfeil zeichnen
Pfeile werden genauso wie Linien gezeichnet. Draw behandelt Pfeile als eine Untergruppe von 
Linien: Linien mit Pfeilspitzen als Linienende. Das Informationsfeld in der Statusleiste bezeichnet 
Pfeile auch nur als Linien. Klicken Sie auf die Schaltfläche Linien und Pfeile oder auf einen 
passenden Pfeil im Teilbereich Formen der Seitenleiste, um einen Pfeil zu zeichnen.
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Linienenden auswählen
Es sind verschiedene Arten von Linienenden (Pfeile, Kreise, Quadrate u. a.) in Draw vorhanden. 
Die Palette des Symbols Linien und Pfeile und die Symbolleiste Linienspitzen bieten einige 
gebräuchliche Kombinationen direkt an, nach der gewünschten Auswahl wird der Pfeil 
dementsprechend gezeichnet. Wenn Sie Enden einer bereits gezeichneten Linie ändern wollen, 
verwenden Sie die Seitenleiste oder den Menüpunkt Format → Linie.

Ein Rechteck oder Quadrat zeichnen
Ein Rechteck zu zeichnen funktioniert ähnlich wie das Zeichnen einer geraden Linie. Wählen Sie 
das Rechtecksymbol  aus der Symbolleiste Zeichnung oder dem Teilbereich Formen der 
Seitenleiste. Wo Sie die linke Maustaste drücken, liegt eine Ecke des Rechtecks, wo Sie dann 
loslassen, befindet sich die schräg gegenüberliegende Ecke.

Drücken Sie die Umschalt-Taste, um ein Quadrat zu zeichnen. Drücken Sie die Alt-Taste um ein 
Rechteck ausgehend vom Zentrum zu zeichnen. Um beide Effekte zu kombinieren, drücken Sie 
die Umschalt- und Alt-Taste gleichzeitig.

Einen Kreis oder eine Ellipse zeichnen
Um eine Ellipse (auch Oval genannt) oder einen Kreis zu zeichnen, benutzen Sie die Schaltfläche 
Ellipse  von der Symbolleiste Zeichnen oder dem Teilbereich Formen der Seitenleiste. (Ein Kreis
ist einfach eine Ellipse, bei der beide Achsen die gleiche Länge haben.) Die gezeichnete Ellipse ist 
die größte Ellipse, die in das (imaginäre) mit der Maus gezeichnete Rechteck passt.

Abbildung 3: Zeichnen einer Ellipse – mit aktivierten Hilfslinien

Abbildung 3 zeigt die Vergrößerung einer Ellipse, wobei die gestrichelten Hilfslinien die Größe des 
imaginären Rechtecks angeben und der gestrichelte rote Pfeil die Zeichenrichtung für die 
Diagonale verdeutlicht.

Einige weitere Möglichkeiten, um eine Ellipse oder einen Kreis zu zeichnen:

• Um einen Kreis zu zeichnen drücken Sie die Umschalt-Taste, während Sie die Maus 
bewegen.

• Um eine Ellipse von der Mitte aus (anstelle von einer Ecke) zu zeichnen, drücken Sie die 
Alt-Taste, während Sie die Maus bewegen.

• Um einen Kreis von der Mitte aus zu zeichnen, drücken Sie die Alt- und Umschalt-Taste 
gleichzeitig, während Sie die Maus bewegen.

• Um eine Ellipse oder einen Kreis zu zeichnen, der am nächsten Rasterpunkt gefangen 
wird, halten Sie die Strg-Taste gedrückt, während Sie die Maus bewegen.

Hinweis

Wenn Sie zuerst die Strg-Taste gedrückt halten und anschließend auf eine der 
Schaltflächen für Linie, Rechteck, Ellipse oder Text klicken, wird ein entsprechendes 
Objekt in einer Standardgröße eingefügt. Alle Eigenschaften wie Größe, Form und 
Farbe sind Standardvorgaben und können – wenn Sie das wünschen – jederzeit 
später geändert werden.
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Kurven zeichnen
Für das Zeichnen von Kurven und Polygonen gibt es eigene Werkzeuge. Die Schaltflächen dieser 
Werkzeuge werden angezeigt, wenn Sie in der Symbolleiste Zeichnung auf den Pfeil rechts neben 
der Schaltfläche Linien und Kurven klicken und so die Symbolleiste Linien (Achtung: anderer 
Name, wenn Sie das Untermenü „abreißen“!) öffnen. Diese Symbolleiste enthält insgesamt acht 
verschiedene Schaltflächen (Abbildung 4). Links ist die angedockte Palette zu sehen, rechts die 
Darstellung mit Beschreibung, die Sie sehen können, wenn Sie auf der Palette Kontextmenü → 
Sichtbare Schaltflächen auswählen. Sie sehen die Beschreibung selbstverständlich auch, wenn 
Sie mit der Maus auf ein Symbol zeigen.

   

Abbildung 4: Symbolleiste Linien

Polygone
Zeichnen Sie die erste Linie vom Startpunkt aus. Halten Sie die linke Maustaste dabei 
gedrückt. Sobald Sie die Maustaste loslassen, zeichnet Draw einen ersten Eckpunkt. Bewegen
Sie die Maus, um zu sehen, wie die zweite Linie aussehen wird. Jeder Mausklick setzt einen 
erneuten Eckpunkt. Ein Doppelklick beendet die Zeichnung. Ein gefülltes Polygon verbindet 
automatisch den ersten mit dem letzten Zeichenpunkt und füllt die Form mit der Standard-
Füllfarbe. Ein Polygon ohne Füllung wird nicht automatisch geschlossen.

Polygon (45°)
Ein Polygon (45°) wird wie ein „normales“ Polygon aus verschiedenen Linien erstellt. Der 
Winkel zwischen den Linien beträgt jedoch ein Vielfaches von 45°.

Freihandlinie
Mit diesem Werkzeug können Sie wie mit einem Bleistift zeichnen. Drücken bzw. halten Sie die
linke Maustaste gedrückt und bewegen Sie die Maus. Es ist nicht notwendig, die Zeichnung mit
einem Doppelklick zu beenden. Sie brauchen dazu nur die Maustaste loszulassen. Wenn Sie 
die gefüllte Freihandlinie ausgewählt haben, wird der Endpunkt automatisch mit dem Start-
punkt verbunden und das Objekt wird mit der entsprechenden Standardfarbe gefüllt.

Kurven und gefüllte Kurven
Die damit gezeichneten Kurven sind Bézier-Kurven. Ihre Handhabung ist nicht ganz einfach. 
Wir zeigen ein einfaches Beispiel, für eine genauere Beschreibung lesen Sie bitte Kapitel 11 
„Fortgeschrittene Zeichentechniken“ im Draw-Handbuch.

Abbildung 5 zeigt verschiedene Stadien beim Zeichnen einer Kurve. Um sie besser vergleichen
zu können, haben wir die Anzeige des Rasters eingeschaltet.

1. Wählen Sie beim Symbol Kurve der Symbolleiste Zeichnung das Symbol Kurve der 
Palette oder das entsprechende Symbol aus dem Teilbereich Formen der Seitenleiste. 
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Ziehen Sie eine waagrechte Linie, indem Sie bei  klicken und die Maustaste halten 
und bei  die Taste loslassen.

2. Bewegen Sie die Maus nach links unten (der rot angedeutete Pfeil zeigt die Cursor-
bewegung), damit Sie ungefähr an dem Punkt anlangen, wie die zweite Grafik der 
Abbildung das zeigt. Doppelklicken Sie dann, damit die Kurve abgeschlossen wird.

3. Der dritte Teil der Abbildung zeigt nun die Struktur der erzeugten Kurve: Beginn und 
Ende der Kurve haben als Tangente die Geraden, die von den Anfangs- und 
Endpunkten zu dem Punkt  verlaufen.

4. Sie können die Kurve nun verändern, indem Sie sie markieren: Sie sehen Griffe, wie im 
dritten Teil angedeutet, den für den unteren Punkt entdecken Sie nur, wenn Sie aus 
dem Punkt heraus mit der Maus eine Ziehbewegung vollführen. Das Ergebnis der 
Bewegung des unteren Griffs auf einen Punkt unterhalb des Startpunktes der Linie 
sehen Sie im rechtesten Teil der Abbildung. (Der waagrechte Griff ist durch eine ähnlich
aussehende Linie angedeutet, Sie sehen nämlich immer nur einen der beiden Griffe!)

Abbildung 5: Bezierkurven: ein einfaches Beispiel

Text schreiben

Benutzen Sie das Textwerkzeug  aus der Standardsymbolleiste, um Text zu schreiben und 
Schriftart, -farbe und andere Textattribute auszuwählen. Klicken Sie an die Stelle, an der Ihr Text 
erscheinen soll, oder klicken und ziehen Sie die Maus, um ein größeres Textfeld zu erzeugen. Das 
Drücken der Eingabetaste bewegt den Cursor in die nächste Zeile.

Wenn Sie den Text geschrieben haben, klicken Sie mit der Maus außerhalb des Textfeldes, um 
den Bearbeitungsmodus zu verlassen. Ein Doppelklick auf den Text wechselt wieder in den 
Bearbeitungsmodus, um Korrekturen und Formatierungen am Text vornehmen zu können.

Wenn Sie das Textwerkzeug benutzen, ist auch die Symbolleiste Textformat sichtbar. Diese enthält
die üblichen Absatz-Attribute wie z. B. fett, kursiv, unterstrichen; Einzüge, Erstzeileneinzug und 
Tabulatoren stehen in Textfeldern nicht zur Verfügung und fehlen daher in dieser Symbolleiste. 
Ebenso zeigt die Seitenleiste die verfügbaren Eigenschaften.

Sie können eine Grafikobjektvorlage erstellen, die Sie dann auch für andere Textrahmen verwen-
den können. Wählen Sie Format → Formatvorlagen oder drücken Sie F11 um das Fenster 
Formatvorlagen zu öffnen oder wählen Sie in der Seitenleiste den Teilbereich Formatvorlagen. 
Eine Grafikobjektvorlage beeinflusst den gesamten Text innerhalb eines Rahmens. Um nur Teile 
des Textes anders zu formatieren, verwenden Sie bitte die direkte Formatierung mithilfe der 
Symbolleiste.

Textrahmen können wie jedes andere Objekt in Draw auch Füllfarben, Schatten oder andere 
Attribute haben. Sie können den Rahmen drehen oder den Text in verschiedenen Winkeln 
anordnen. Diese Optionen erreichen Sie mit einem rechten Mausklick auf das Objekt.
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Legenden

Benutzen Sie das Werkzeug Legenden , um Legenden oder auch „Sprechblasen“ zu erstellen. 
Sie finden das Werkzeug Legenden ebenfalls in der Symbolleiste Zeichnung oder im Teilbereich 
Formen der Seitenleiste.

Texte in Objekten
Wenn Sie ein Objekt ausgewählt haben und auf dieses doppelklicken oder F2 drücken (bzw. das 
Textwerkzeug in der Symbolleiste Zeichnen benutzen), wird Text in die Mitte des Objektes 
geschrieben und bleibt auch innerhalb des Objektes. Nahezu jede Art von Objekt kann solch ein 
zusätzliches Textelement enthalten. Diese Texte weisen kleine Unterschiede bezüglich Textposi-
tionierung und Silbentrennung im Vergleich zu Texten in Textrahmen auf.

Um den Text zu formatieren, können Sie das Menü Format → Text…, die Symbolleiste Text (die 
automatisch eingeblendet wird, wenn Sie in den Text klicken) oder die Seitenleiste verwenden.

Für weitere Details bezüglich Text lesen Sie bitte Kapitel 2 „Zeichnen von Basisformen“ und Kapitel
10 „Fortgeschrittene Zeichentechniken“ des Draw-Handbuchs.

Klebepunkte und Verbinder

Klebepunkte
Alle Draw-Objekte haben eine Anzahl unsichtbarer Klebepunkte, die dann sichtbar werden, wenn 
Sie einen der Verbinder, die Sie über die Schaltfläche Verbinder (s. „Verbinder“ auf Seite 14) in der
Symbolleiste Zeichnung finden, auswählen und dann den Mauszeiger über das oder in die Nähe 
des Objekts bewegen (Abbildung 6).

Abbildung 6: Rechteck mit Klebepunkten

Die meisten Objekte haben vier Klebepunkte, wie in Abbildung 6 gezeigt, in den Mittelpunkten des 
begrenzenden Rechtecks. Sie können mit Hilfe der Symbolleiste Klebepunkte zusätzliche Klebe-
punkte hinzufügen oder diese anpassen. Die Symbolleiste zeigen Sie über die Schaltfläche 
Klebepunkte  in der Symbolleiste Standard an (Abbildung 7). Wenn das Objekt, dem Sie 
Klebepunkte hinzufügen wollen, in der Anzeige recht klein ist, wird ein neuer Klebepunkt oft  bei 
einem vorhandenen Klebepunkt einrasten; vergrößern Sie dann am besten temporär den Maßstab 
über Ansicht → Maßstab oder die entsprechenden Felder in der Statusleiste.

Abbildung 7: Die Symbolleiste Klebepunkte
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Die Klebepunkte, die Sie hinzufügen, sind durch ein Kreuz oder Plus-Zeichen gekennzeichnet und 
werden sichtbar, wenn Sie die Schaltfläche Klebepunkte  aktivieren oder dabei sind, einen 
Verbinder zu verwenden. Wenn die Schaltfläche aktiviert ist und sie einen solchen Klebepunkt 
anklicken (wenn Sie in seiner Nähe sind, ändert sich das Cursor-Symbol zu einem weißen Quadrat
neben dem Pfeil), ist er markiert, und Sie können den Klebepunkt dann verschieben oder auch 
wieder löschen.

Viele Formen haben aber auch standardmäßig bereits weitere Klebepunkte über die vier Mittel-
punkte des begrenzenden Rechtecks hinaus. Auch diese werden durch ein Kreuz gekennzeichnet,
sie sind aber geschützt.

Klebepunkte unterscheiden sich von den Griffen (kleine blaue oder grüne Quadrate um ein Ob-
jekt). Die Griffe sind für Größenänderungen von Objekten zuständig, die Klebepunkte befestigen 
einen Verbinder an einem Objekt. Klebepunkte können Sie in Abbildung 8 und 10 sehen.

Verbinder
Verbinder sind Linien oder Pfeile, deren Enden automatisch an den Klebepunkten eines Objektes 
andocken. Wenn Sie das Objekt bewegen, bleibt der Verbinder mit diesem verbunden und ändert 
seine Form der neuen Situation entsprechend. Verbinder sind besonders nützlich, wenn Sie 
Organigramme erstellen. Sie können die einzelnen Blöcke verschieben und alle verbundenen 
Objekte bleiben verbunden.

Abbildung 8 zeigt zwei Draw-Objekte mit einem Verbinder, nur beim rechten Objekt sieht man die 
Klebepunkte.

Abbildung 8: Zwei Objekte mit Verbinder und Klebepunkten

Draw bietet eine große Auswahl an verschiedenen Verbindern und Verbinderfunktionen. Öffnen Sie
die Symbolleiste Verbinder, indem Sie auf den Pfeil direkt neben dem Symbol Verbinder klicken.

Verbinder verbinden
Verbinder, die mehr Ecken als die vorgegebenen Verbinder haben, können Sie erzeugen, indem 
Sie Verbinder verbinden. Sobald Sie den Endpunkt eines Verbinders dem Endpunkt eines anderen
nähern (Abbildung 9), schnappt der Verbinder ein.

Abbildung 9: Verbinden von Verbindern

Durch einen solchen „Verbinder“ können Sie nun z.B. ein anderes Objekt umfahren (Abbildung 10).
Wenn Sie einen der beiden Verbinder anklicken, sehen Sie dessen Anfasser und können ihn wie 
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gewohnt verschieben. Aufpassen müssen Sie nur beim Verbindungspunkt (kreisförmig) der beiden 
Verbinder: wenn der Verbinder markiert ist, mit dem Sie eingerastet haben, führt eine Bewegung 
des Anfassers dazu, dass die beiden wieder getrennt werden; ist dagegen der andere markiert, 
bleiben die Verbinder verbunden und die Form ändert sich entsprechend der Verschiebung.

Abbildung 10: Zwei verbundene Verbinder (grün)

Mehr Details zu Verbindern und Klebepunkten finden Sie in Kapitel 9 „Organigramme, 
Flussdiagramme und mehr“ im Draw-Handbuch.

Zeichnen von geometrischen Formen

Draw bietet eine Auswahl von speziellen geometrischen Formen an, die häufig benötigt werden. 
Sie können über Untermenüs der Symbolleiste Zeichnung aufgerufen werden, nämlich über 
Grundformen, Symbol, Pfeile, Legende, Sterne und Banner. Auch der Teilbereich Formen der 
Seitenleiste bietet diese an. Die Handhabung ist im Prinzip die gleiche wie für Rechtecke und 
Ellipsen, die oben beschrieben wurde.

Zu all diesen Formen können Sie, wie in „Texte in Objekten“ auf Seite 13 beschrieben, Text 
hinzufügen.

Objekte auswählen

Ein einzelnes ausgewähltes Objekt wird durch kleine blaue Quadrate an den Ecken und Seiten-
mitten des es umgebenden Rechtecks gekennzeichnet. Haben Sie mehrere Objekte ausgewählt 
oder eine Gruppe (s. „Gruppierung“ auf Seite 25), dann haben die Quadrate eine grüne Farbe.

Es gibt mehrere Möglichkeiten, ein Objekt auszuwählen:

Direkte Auswahl
Der einfachste Weg, ein Objekt auszuwählen, ist das direkte Anklicken. Um ein Objekt 
auszuwählen, das nicht gefüllt ist (also kein Muster oder keine Füllfarbe hat), klicken Sie auf den 
Rand des Objektes, ansonsten auch irgendwo auf die Fläche. Wenn Sie erneut auf das Objekt 
klicken, wird der Drehmodus ausgewählt, s. „Drehung“ auf Seite 20. Wenn Sie die Umschalt-Taste 
beim Klicken gedrückt halten, wird die bisherige Auswahl durch das angeklickte Objekt erweitert.

Klicken Sie anderswo hin, um die Auswahl aufzuheben.

Auswahl verdeckt liegender Objekte
Selbst wenn Objekte hinter anderen Objekten angeordnet und somit nicht oder höchstens wegen 
der Transparenz der davor liegenden Objekte sichtbar sind, können sie dennoch ausgewählt 
werden. Drücken Sie die Alt-Taste und klicken Sie in die Region, in der sich das Objekt befindet. 
Wenn Sie, falls Sie das Objekt nicht wegen der Transparenz sehen konnten, es trotzdem getroffen 
haben, sehen Sie die Markierungspunkte (kurz wird sogar das Objekt, z.B. mit seiner Flächen-
farbe, sichtbar); sie können nun das Objekt bearbeiten. Sollten sich mehrere verdeckte Objekte 
dort befinden, halten Sie die Alt-Taste gedrückt und klicken Sie so lange, bis Sie das gewünschte 
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Objekt erreichen. Von da aus können Sie die übereinander liegenden Objekte in umgekehrter 
Reihenfolge durchlaufen, indem Sie beim Klicken Umschalt+Alt drücken.

Hinweis

Die beschriebene Vorgehensweise funktioniert üblicherweise in Windows und auf 
Macs – auf einem Linux-System leider nicht. Falls die beschriebene Methode mit der
Alt-Taste bei Ihnen nicht funktioniert, benutzen Sie die nachfolgend beschriebene 
Vorgehensweise mit der Tabulator-Taste.

Auswahl über den Navigator
Den Navigator rufen Sie über das Kompasssymbol in der Seitenleiste, Ansicht → Navigator oder 
F5 auf (s. auch das Kapitel „LibreOffice Einführung“ dieses Handbuchs). Im Navigator werden alle 
Bestandteile aller Folien aufgelistet. Durch Anklicken können Sie darin einen solchen Bestandteil 
auswählen – allerdings nur, wenn er einen Namen hat, der ihm explizit vergeben wurde, der 
standardmäßig vergebene Name (z. B. Form2) genügt dafür nicht. Den Namen können Sie in 
machen Fällen über das Kontextmenü vergeben, aber auf jeden Fall über Format → Name...

Hinweis
Die sofortige Anzeige des geänderten Namens im Navigator funktioniert nur dann 
zuverlässig, wenn das Dokument bereits gespeichert wurde (und eventuell sogar 
geschlossen und wieder geöffnet wurde).

Auswahl mit der Tastatur
Um ein Objekt mithilfe der Tastatur auszuwählen (auch solcher, die von einem anderen Objekt 
verdeckt werden), drücken Sie die Tabulator-Taste so oft, bis das gewünschte Objekt ausgewählt 
ist; die Objekte werden offensichtlich in der Reihenfolge ihrer Erzeugung durchlaufen. Um in umge-
kehrter Richtung durch die verschiedenen Objekte zu wandern, drücken Sie Umschalt+Tabulator. 
Diese Vorgehensweise kann langwierig sein, wenn Sie eine große Anzahl an Objekten in Ihrem 
Dokument haben.

Mehrere Objekte auswählen
Wenn ein Objekt ausgewählt ist, können Sie durch Anklicken bei gedrückter Umschalt-Taste 
weitere Objekte auswählen. Alle so angeklickten Objekte bilden eine gemeinsame Auswahl, für die 
sie die im Folgenden beschriebenen Aktionen wie Formatierung, Verschiebung … gemeinsam 
ausführen können, so lange die Auswahl noch aktiv ist. Vergleichen Sie dazu auch „Gruppierung“ 
auf Seite 25.

Auswahl durch Einrahmung

Sie können mehrere Objekte auf einmal auswählen, indem Sie mit der 
Maus einen Rahmen um alle Objekte ziehen. Hierfür muss die 
Schaltfläche Auswahl  auf der Symbolleiste Zeichnung aktiv sein. Es 
werden nur die Objekte ausgewählt, die vollständig innerhalb des 
Rahmens liegen. Auch hier können Sie durch Drücken der Umschalt-Taste
weitere Rahmen ziehen und so die Auswahl erweitern.

Objekte anordnen

In einer komplexen Zeichnung können mehrere Objekte übereinander liegen und sich (teilweise) 
überdecken. Die Überdeckung ergibt sich aus der Reihenfolge der Erzeugung der Objekte, die 
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neuesten liegen am weitesten oben. Um diese Anordnung zu verändern, d. h. ein Objekt im Stapel 
nach vorne oder hinten zu verschieben, wählen Sie das Objekt aus und wählen Sie dann Ändern 
→ Anordnung oder im Kontext-Menü Anordnung. Durch nach vorne oder nach hinten verschie-
ben Sie das Objekt relativ zu allen anderen Zeichnungsobjekten um eine Ebene nach vorne oder 
hinten. Das muss keinen sichtbaren Effekt haben, denn das in der Reihenfolge nächste Objekt hat 
vielleicht gar keine Überschneidung mit dem ausgewählten. Wiederholen Sie die Aktion dann, bis 
das gewünschte Ergebnis erreicht ist. 
In komplizierteren Fällen ist es oft effektiver, sich grundsätzlich die Schichtung klarzumachen und 
dann jeweils das noch weiter hinten liegende Objekt durch ganz nach hinten zu platzieren, bis Sie
beim wirklich ganz hinten liegenden angelangt sind, oder umgekehrt.

Mit dem Befehl … Vor das Objekt (oder hinter) können Sie anschließend ein Objekt anklicken, vor
(oder hinter) das das gewählte Objekt angeordnet wird.

Diese Optionen sind ebenfalls über die Schaltfläche Anordnung in der Symbolleiste Linie und 
Füllung erreichbar. Umschalt+Strg+Plus ist ein Tastaturkürzel für ganz nach vorne, Strg+Plus für 
nach vorne, Umschalt+Strg+Minus für ganz nach hinten und Strg+Minus für nach hinten.

Draw bietet auch ein Werkzeug für die genaue Ausrichtung mehrerer Objekte an. Details hierzu 
finden Sie im Draw Handbuch.

Verschieben und Größenanpassung von Objekten

Über Format → Position und Größe oder über Kontextmenü → Position und Größe können 
Sie die Position und Größe des gewählten Objekts direkt ändern. Oft ist es jedoch bequemer, die-
se Werte mit der Maus oder den Pfeiltasten zu ändern und höchstens feine Korrekturen über den 
Dialog vorzunehmen. In der Statusleiste werden –  links – Positions- und – rechts davon – 
Größenangaben des ausgewählten Objekts angezeigt. Sie können diese Angaben nutzen, wenn 
Sie mit der Maus die Größe oder Position eine Objekts ändern. 

Verschieben von Objekten

Um ein Objekt zu verschieben, wählen Sie es aus und klicken innerhalb der
Kontur des Objektes. Halten Sie die linke Maustaste gedrückt und 
verschieben das Objekt mit der Maus.

Während des Verschiebevorgangs wird die Kontur des Objektes halbtrans-
parent dargestellt, (Phantombild) um Ihnen bei der Neupositionierung des 
Objektes zu helfen.

Wenn das Phantombild an der passenden Stelle erscheint, lassen Sie die 
Maustaste los.

Sie können auch die Pfeiltasten verwenden, um das Objekt zu verschieben.
Bei Einsatz der Umschalt-Taste erreichen Sie größere Verschiebungen.

Größenänderung von Objekten

Um die Größe eines ausgewählten Objektes oder einer Gruppe von 
Objekten mit der Maus zu ändern, verschieben Sie einen der Griffe, die
um die Auswahl angeordnet sind. Wie in der Abbildung rechts gezeigt, 
erscheint eine halbtransparente Version des neuen Objekts.

Das Ergebnis hängt davon ab, welchen Griff Sie verwenden. Um ein 
Objekt nur in einer Richtung zu ändern, nutzen Sie den 
entsprechenden Griff an der Seite. Um ein Objekt in zwei Richtungen 
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zu verändern, nutzen Sie einen der Griffe an den Ecken.

Hinweis
Wenn Sie die Umschalt-Taste drücken, während Sie die Größe ändern, wird die 
Größenänderung so ausgeführt, dass das Seitenverhältnis (Höhe/Breite) des 
Objektes gleich bleibt.

Fangfunktionen
Sie können Position und Größe von Objekten sehr genau über den zugehörigen Dialog einstellen, 
häufig – und gerade, wenn Sie mit der Maus die Objekte platzieren – ist das Ziel jedoch eher, dass
die Kanten eine gemeinsame Fluchtlinie haben, dass Objekte exakt aneinander anschließen usw.

Zu diesem Zweck bietet LibreOffice diverse Fangfunktionen an. Wir beschreiben Sie knapp, 
Näheres finden Sie im Draw-Handbuch.

Raster
Über Ansicht → Raster → Raster sichtbar können Sie die Anzeige eines Rasters einschalten 
(das nicht gedruckt wird), mit Ansicht → Raster → Am Raster fangen schalten Sie ein, dass die 
Seiten (des umschließenden Rechtecks) des Objekts auf den Rasterlinien zu liegen kommen, 
wenn Sie das Objekt verschieben oder seine Größe ändern.

In Abbildung 11 sehen Sie das Raster (das durch die Wahl einer kräftigeren Farbe in Extras → 
Optionen → Anwendungsfarben → Zeichnung/Präsentation → Gitter deutlicher sichtbar 
gemacht wurde) in einer starken Vergrößerung. Das Raster wird grob durch die punktierten Linien 
angedeutet, das Einrasten erfolgt aber sehr fein anhand der einzelnen Punkte der Rasterlinie.

Abbildung 11: Das Raster

Wenn Sie nun ein Objekt bewegen oder seine Größe ändern, wird dies in Schritten entsprechend 
der Rastereinteilung geschehen. Wenn die Größe des Objekts nicht mit dem Raster kompatibel ist,
ist dies bei der Verschiebung nicht auf Anhieb erkennbar, weil entweder die rechte oder die linke 
bzw. die obere oder die untere Begrenzung einrastet.

Hinweis
Oft ist es hilfreich, über Ansicht → Maßstab oder Maßstabsfunktionen ganz rechts 
in der Statusleiste die Vergrößerung recht hoch einzustellen, um das exakte 
Einrasten zu kontrollieren.

Fanglinien und -punkte
Das Raster bietet eine gleichmäßige Einteilung der Zeichnungsfläche. Wenn Sie individuelle 
Abstände benötigen, können Sie eigene Fanglinien definieren. Über Ansicht → Fanglinien → 
Fanglinien sichtbar schalten Sie zunächst ein, dass Sie Fanglinien überhaupt sehen, mit Ansicht
→ Fanglinien → An Fanglinien fangen legen Sie fest, dass die Fanglinien auch berücksichtigt 
werden.
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Fanglinien und -punkte fügen Sie über Einfügen → Fangpunkt/-linie einfügen… ein. Fanglinien 
können Sie auch durch Ziehen mit der Maus aus den Linealen (ziehen Sie z.B. mit gedrückter 
Maustaste aus dem waagrechten Lineal die Maus in die Zeichnung hinein) erzeugen. Sie können 
Sie anschließend mit der Maus verschieben. Leider scheint es keine Möglichkeit zu geben, dies 
ohne Maus zu bewerkstelligen.

Auch Fanglinien und -Punkte werden nicht gedruckt. Die Ecken oder Seiten von Objekten rasten 
ähnlich wie beim Raster an der Fanglinie oder am Fangpunkt ein.

Weitere Fangmöglichkeiten
Sie können auch Objektrahmen oder Objektpunkte von Objekten, die sich in Ihrer Zeichnung 
befinden, für das Fangen von Objekten verwenden. Häufig nützlich ist z.B. das Fangen von Linien-
oder Pfeilenden an einem der Griffe (Ecken und Seitenmittelpunkte) des Objekts.

Einstellungen für das Fangen
Über Extras → Optionen → LibreOffice Draw → Raster können Sie die Einstellungen für das 
Fangen beeinflussen (Abbildung 12). Manche lassen sich auch, wie oben beschrieben, durch 
Menüpunkte ändern.

Wichtig ist vor allem der Fangbereich beim Fangen an Linien, Rändern, Rahmen und Punkten: hier
können Sie die Empfindlichkeit für das Fangen einstellen. Außerdem stellen Sie ein, welche von 
den Fangoptionen aktiv sind.

Abbildung 12: Einstellungen für das Fangen

Drehung und Neigung

Wir stellen hier nur die Grundfunktionen zu diesem Thema vor, weiterführende Informationen 
finden Sie im Draw-Handbuch.

Um ein Objekt zu drehen oder zu neigen, müssen Sie zunächst den Dreh-/Neige-Modus wählen 
(jetzt unspezifisch „Umwandlungen“ genannt). Sie erreichen ihn auf mehreren Wegen:

• Klicken Sie ein ausgewähltes Objekt ein weiteres Mal an.
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• Wenn das Symbol Umwandlungen der Symbolleisten Standard oder Linie und Füllung ein 

Bild wie  oder  zeigt, können Sie es einfach anklicken.

• Wenn es ein anderes Bild zeigt (was der Fall ist, wenn Sie zuletzt eine andere Umwand-
lung verwendet haben), dann klicken Sie auf das Dreieck rechts neben dem Bild zum 
Öffnen der Symbolpalette Umwandlungen und wählen dort das Symbol für die Drehung 
aus.

In allen Fällen ändert sich die Darstellung des gewählten Objekts: Die Ecken und Seitenmittel-
punkte sind rote Kreise bzw. Ellipsen.

Die Drehung des Objekts erfolgt nun über die Eckpunkte des das Objekt umschreibenden Recht-
ecks, die Neigung über die Seitenmittelpunkte. Sie sehen das auch über das unterschiedliche 
Maussymbol: im ersten Fall ein kreisförmiger Pfeil mit zwei Spitzen, im zweiten zwei Halbpfeile mit 
entgegengesetzt gerichteten Spitzen.

Drehung
Um das Objekt zu drehen, verwenden Sie seine Eckpunkte, die Sie mit der Maus markieren und 
bewegen. Der Drehpunkt befindet sich standardmäßig im Zentrum des Objekts – durch einen Kreis
symbolisiert – , Sie können ihn aber mit der Maus verschieben.

Hinweis

Die Drehung arbeitet leicht unterschiedlich, wenn Sie ein 3D-Objekt drehen, da die 
Drehung im dreidimensionalen Raum geschieht und nicht nur in einer Ebene. Lesen 
Sie Kapitel 7 „Arbeiten mit 3D-Objekten“ des Draw-Handbuchs, um Genaueres 
hierüber zu erfahren.

Abbildung 13: Drehung eines Objekts (mit verschobenem Drehpunkt)

Wenn Sie während der Drehung die Umschalt-Taste gedrückt halten, wird die Drehung nur für 
Vielfache von 15° ausgeführt.

Sie können die Drehung aber auch über Format → Position und Größe → Drehung, 
Kontextmenü → Position und Größe → Drehung oder über den entsprechenden Abschnitt der 
Seitenleiste festlegen.

Neigung
Um ein Objekt zu neigen, nutzen Sie die roten Griffe, die in der Mitte der Seiten des ausgewählten 
Objektes angebracht sind. Der Mauszeiger verändert sich in zwei Pfeile, die in die jeweils entge-
gengesetzte Richtung zeigen. (Es handelt sich nicht um eine Scherung, bei der die Höhe des 
Parallelogramms und damit seine Fläche gleich bleibt; vielmehr bleibt die Länge der geneigten 
Seite gleich.)
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Die Seite gegenüber dem mittleren Griff, der für die 
Neigungsoperation verwendet wird, bleibt fixiert. Die 
anderen Seiten und Ecken bewegen sich relativ dazu, wenn 
Sie den Mauszeiger bewegen.

Wie bei der Drehung können Sie auch hier die Neigung in Schritten von 15° ausführen, indem Sie 
die Umschalt-Taste drücken, während Sie die Maus bewegen.

Sie können die Neigung aber auch über Format → Position und Größe → Neigung oder 
Kontextmenü → Position und Größe → Neigung festlegen.

Objekte verändern

Um die Eigenschaften eines Objektes (wie zum Beispiel die Farbe oder die Rahmenbreite) zu 
verändern, können Sie die Symbolleiste Linie und Füllung oder Text, die Seitenleiste oder das 
Kontextmenü verwenden.

Hier bietet sich eine Fülle von Möglichkeiten, das Objekt zu verändern, von denen Farbe, 
Linienbreite, Schatten u.ä. auf der Hand liegen, sobald Sie den entsprechenden Dialog oder die 
Seitenleiste anschauen, andere wie die über das Symbol Effekte in den Symbolleisten Standard 
und Linie und Füllung angebotenen sehr speziell sind. Wir gehen daher nur kurz auf die wichtig-
sten Eigenschaften ein, Genaueres finden Sie im Draw-Handbuch.

Linien
Die einfachsten Objekte aus Sicht der Formatierung sind wohl Linien, wobei dies Strecken 
(Abschnitte von Geraden), Pfeile, Kanten von Flächen, Kurven u.ä. beinhaltet. Gemeinsam ist 
ihnen, dass es sich um ideell eindimensionale Objekt handelt, auch wenn sie natürlich auf dem 
Bildschirm oder Papier eine Fläche bedecken, sonst wären sie ja nicht sichtbar.

Die Eigenschaften von Linien wie Strichstärke, Linienstil (gepunktet, gestichelt usw.), Linienfarbe…
können Sie über den Menüpunkt Linie in allen genannten Menüvarianten beeinflussen.

Linienenden
Für manche Arten von Linien (Stecken, Kurven) können Sie auch die Form der Linienenden 
bestimmen; Sie haben für jedes Ende die Wahl unter knapp zwei Dutzend unterschiedlichen 
Linienenden.

Flächen
Bei flächigen Objekten können Sie bestimmen, wie die Fläche (Menüpunkt Fläche in allen 
genannten Menüvarianten) gefüllt werden soll:

• gar nicht

• mit einer Farbe

• mit einem Farbverlauf zwischen zwei Farben, wobei die Richtung des Farbverlaufs sehr 
variabel bestimmt werden kann

• durch Schraffuren oder andere Muster, bei denen Sie jeweils die beiden Farben wählen 
können
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• durch Bilder, die durch Wiederholung die Fläche ausfüllen und deren Größe usw. Sie 
einstellen können

Probieren Sie selbst die vielfältigen Möglichkeiten aus.

Schatten
Sowohl Linien als auch Flächen können Sie Schatten zuordnen, bei denen Sie die Lage zum 
Bezugsobjekt, seine Farbe und Transparenz festlegen können.

Texte
Für Texte – ob das nun Texte zu einer geometrischen Form sind oder Textfelder – können Sie für 
Absätze oder Gruppen von Zeichen die meisten der aus Writer bekannten Eigenschaften wie 
Zeilenabstand, Einrückung, Nummerierung und Aufzählung, Schriftart und -größe usw. festlegen. 
Für ein Textfeld können Sie auch nachträglich Flächen- und Linienattribute definieren.

Formatvorlagen verwenden
Wenn Sie mehrere Objekte haben, denen Sie die gleichen Formateigenschaften geben wollen, 
dann können Sie dafür eine Formatvorlage erstellen (oder eine der vorhandenen entsprechend 
abändern). Der Vorteil der Verwendung von Formatvorlagen gegenüber dem Kopieren eines 
Formats liegt darin, dass bei einer Änderung der Formatvorlage alle Objekte, denen diese 
zugewiesen ist, automatisch angepasst werden. Das Arbeiten mit Vorlagen wird im Kapitel 3 
„Formate und Vorlagen“ dieses Handbuchs beschrieben.

Weitere Effekte

Draw ermöglicht Ihnen, viele Spezialeffekte auf Objekte und Gruppen von Objekten anzuwenden. 
Stellvertretend beschreibt dieser Abschnitt einige wenige dieser Effekte. Informationen zu weiteren 
Effekten finden Sie in Kapitel 4 „Ändern der Objektattribute“ des Draw-Handbuchs.

Spiegeln
Man benötigt häufig das Spiegelbild eines Zeichnungsobjekts, z. B. um damit ein symmetrisches 
Objekt zu erzeugen.

Einfaches Spiegeln waagrecht oder senkrecht
Für diese wahrscheinlich gebräuchlichste Form des Spiegelns bieten Ändern → Spiegeln, 
Kontextmenü → Spiegeln oder Seitenleiste → Spiegeln jeweils beide Optionen an.

Spiegeln eines Objekts an einer Achse
Wenn Sie ein Objekt an einer von der waagrechten oder senkrechten abweiichenden Achse 
spiegeln wollen, gehen Sie folgendermaßen vor:

Wählen Sie ein Objekt und den Menüpunkt wie oben 
beschrieben oder klicken Sie auf das Symbol 
Spiegeln  der Symbolpalette Umwandlungen. Eine 
gestrichelte Linie wird senkrecht durch das Objekt 
angezeigt.
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Die gestrichelte Linie ist die Symmetrieachse. Das 
Objekt wird an dieser Achse gespiegelt. Verschieben 
Sie die Enden der Achse mit der Maus um die 
Orientierung der Achse festzulegen.

Ergreifen Sie dann einen der acht grünen Griffe und 
bewegen Sie ihn auf die andere Seite der gepunkteten
Linie. Die neue Position des Objektes wird angezeigt, 
sobald Sie die Maus los lassen.

Formveränderungen eines Objektes
Die Symbole Umwandlungen in den Symbolleisten Standard und Linie und Füllung und die 
Symbolleiste Umwandlungen – die nichts anderes als die „abgerissene“ Palette des Symbols 
Umwandlungen ist – bieten diverse Werkzeuge, mit denen Sie die Ecken und Kanten eines 
Objekts verzerren können.

Schrittweise Übergänge
Sie können ausgehend von einem oder zwei Objekten eine Folge von Zwischenobjekten erzeugen,
bei denen schrittweise die Eigenschaften des Quell- in die des Zielobjekts umgewandelt werden. 
Wir zeigen Ihnen für zwei Verfahren Beispiele. Es empfiehlt sich, die erzeugten Objekte gleich zu 
gruppieren (s. „Gruppierung“ auf Seite 25), damit sie nicht aus Versehen eines davon verschieben.

Möglicherweise wirken die Übergänge in den Beispielen extrem und daher wenig brauchbar, aber 
wenn Sie Sie die Variationsmöglichkeiten behutsam einsetzen, sind die Abfolgen der Objekte 
Vielleicht  schon eher brauchbar. Bedenken Sie auch immer, dass grundsätzlich alles, was in Draw
möglich ist, auch in Impress zur Verfügung steht; dort sind vordergründige Effekte eventuell noch 
besser einsetzbar.

Vervielfältigen
Beim Vervielfältigen wird ausgehend von einem Quellobjekt eine Folge von Kopien diese Objekts 
erstellt, von denen sich jede in mehreren Eigenschaften vom vorherigen Glied der Folge 
unterscheidet. Die Abweichungen zwischen einem Glied der Folge und dem nächsten können Sie 
in einem Dialog bestimmen.

Der Befehl für diese Funktion wird derzeit nicht mehr standardmäßig angeboten, sie können ihn 
aber über Extras → Anpassen… in ein Menü oder eine Symbolleiste einfügen, z. B. wie früher in 
das Menü Bearbeiten.

Um das Vervielfältigen zu starten, klicken Sie auf ein Objekt oder eine Gruppe von Objekten und 
wählen Sie anschließend den Befehl da, wo Sie ihn aktiviert haben. Der in Abbildung 14 gezeigte 
Dialog Vervielfältigen erscheint.
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Abbildung 14: Dialog Vervielfältigen

Wenn die Optionen in diesem Dialogfeld auf ein Rechteck angewendet werden, sieht das Ergebnis
wie folgt aus.

Abbildung 15: Beispiel für ein vervielfältigtes Objekt

Überblendung
Die Überblendung transformiert eine Form in eine andere. Das Ergebnis ist eine neue Gruppe von 
Objekten, die alle Schritte von ersten bis zum letzten Schritt beinhaltet.

Die Überblendung wird wie das Vervielfältigen neuerdings nicht mehr standardmäßig angeboten, 
sie können sie aber über Extras → Anpassen… in ein Menü oder eine Symbolleiste einfügen. Um
eine Überblendung durchzuführen, wählen Sie zunächst zwei Objekte aus. Wählen Sie 
anschließend den Befehl da, wo Sie ihn eingefügt haben.

Wählen Sie im Dialog Überblenden die Anzahl der Schritte aus, die die Anzahl der Zwischenobjek-
te festlegt.. Das Ergebnis der Überblendung für zwei Paare von geometrischen Objekten zeigt
Abbildung 16.
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Abbildung 16: Ergebnis der Überblendung

Erzeugen eines neuen Objekts aus bestehenden Objekten

Gruppierung
Wenn Sie mehrere Objekte ausgewählt haben, können Sie, wie in „Mehrere Objekte auswählen“ 
auf Seite 16 beschrieben, für alle gemeinsam Formateigenschaften setzen, sie gemeinsam 
verschieben oder auch die Gesamtgröße ändern, wobei dann die einzelnen Objekte alle im 
gleichen Maßstab verändert werden. Diese Zusammenführung mehrerer Objekte ist allerdings nur 
temporär, sobald Sie ein anderes Objekt wählen oder auf die leere Fläche klicken, ist der 
Zusammenhang verloren. Wenn Sie die zusammengeführten Objekte für einen längeren Zeitraum 
oder sogar grundsätzlich als Einheit behandeln möchten, können Sie sie über Form → 
Gruppierung → Gruppieren in ein Objekt zusammenfassen, dass Sie nunmehr als Einheit 
behandeln können, bis Sie es durch Form → Gruppierung → Gruppierung aufheben wieder in 
einzelne Objekte auflösen oder, wenn Sie das nur für eine kurze Änderung benötigen, durch Form 
→ Gruppierung → Gruppe betreten für den Zweck der Bearbeitung in einzelne Objekte zerlegen.
Wenn Sie nach der Änderung an einem Objekt dann Form → Gruppierung → Gruppe verlassen
wählen, ist die Gruppe weiterhin als Einheit vorhanden.

Eine solche Gruppierung erleichtert oder garantiert dauerhaft oder zumindest für kurze Zeit die 
gleichartige Behandlung mehrerer Objekte. Sie bewahrt Sie auch selbst eventuell vor flüchtigen 
unvollständigen Änderungen.

Sie können ein solches Gruppenobjekt auch mit anderen Objekten zu einer größeren Gruppe 
zusammenführen usw.

Kombinationen von flächigen Objekten

Hinweis
Beachten Sie, dass der Begriff „Kombination“ (wohl mangels eines griffigen anderen 
Bezeichners) auch für eine der Kombinationsmethoden verwendet wird.

Wenn Sie mehrere flächenförmige Objekte haben, können Sie sie durch verschiedene Verfahren 
kombinieren und dadurch daraus neue Objekte generieren. Wir zeigen das am Beispiel von zwei 
Rechtecken (Abbildung 17).
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Abbildung 17: Kombination von flächigen Objekten

Links sehen Sie die Ausgangssituation der beiden Rechtecke. Wählen Sie beide aus und dann 
einen der Befehle, die unter den fünf Ergebnisobjekten rechts stehen.Sie erreichen die Befehle 
über Form direkt oder über Kontextmenü → Form. In blasser Farbe wird in der Abbildung die 
Lage der Ausgangsobjekte angezeigt.

In Begriffen der Mengenlehre entspricht das Ergebnis des Verschmelzens der Vereinigungsmenge,
das des Schneidens der Schnittmenge, das des Subtrahierens der Differenzmenge und das des 
Kombinierens der symmetrischen Differenzmenge. Das Verbinden lässt sich nicht mengentheore-
tisch beschreiben und bringt mitunter erstaunliche Ergebnisse hervor.

Es wird bei dem am weitesten hinten liegenden ausgewählten Objekt begonnen, von dem die 
Eigenschaften, wie im Beispiel die Farbe übernommen werden; im Fall des Subtrahierens werden 
auch von diesem die Bereiche entfernt, die sich mit den anderen Objekten überschneiden.

Hinweis
Durch diese Aktionen wird ein neues Objekt geschaffen, sie können dieses nicht wie
bei Gruppen wieder zerlegen. Sie können nur durch Rückgängig wieder die 
Ausgangssituation herstellen.

Verbinden von Linien
Der Menüpunkt Ändern → Verbinden hat für Linien eine andere Wirkung, die manchmal eine gün-
stige Bearbeitung ermöglicht. Als Beispiel wollen wir die Figur eines Drachens zeichnen (Abbildung
18).

Relative Positionierung von Objekten

Sie können mehrere Objekte relativ zu ihren jeweiligen Positionen neu platzieren. Wählen Sie dazu
alle betroffenen Objekte aus und dann Form → Ausrichtung oder Form → Verteilung; erstere 
Wahl ist auch übers Kontextmenü erreichbar. Sie können dann

• über die Ausrichtung (ab zwei ausgewählten Objekten) Objekte links, rechts, zentriert, 
oben, unten oder mittig zueinander ausrichten

• über die Verteilung (ab drei Objekten) Objekte horizontal oder vertikal gleichmäßig 
verteilen.

Abbildung 18 zeigt als Beispiel die Verteilung von drei Objekten (links vor, rechts nach der Aktion) 
horizontal und vertikal zentriert: die am weitesten links/oben und rechts/unten liegenden Objekte 
behalten ihre Position, die dazwischen liegenden werden verschoben.
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Abbildung 18: Verteilen von Objekten

Bilder und andere Medien einfügen und bearbeiten

Draw verfügt über eine Reihe von Funktionen, mit denen Sie zum Beispiel Fotos oder eingescann-
te Bilder, aber auch andere Dateitypen einfügen und bearbeiten, aber auch in verschiedene For-
mate umwandeln können. Draw kann mit allen üblichen Grafikformaten umgehen.

Sie können Bilder und andere Medien u.a. aus unterschiedlichen Quellen einfügen:

• aus der Gallery: verwenden Sie Einfügen → Medien → und dann Gallery..., Fontwork..., 
Audio/Video… usw. (lesen Sie Kapitel 11 „Grafiken, Bilder und Fontworks verwenden“ 
dieses Handbuchs)

• aus Verzeichnissen, die entweder fest auf ihrem Computer liegen oder über Server oder 
z.B. Digitalkameras temporär zur Verfügung stehen, durch Einfügen → Bild.

•  – sofern möglich – durch einfaches Kopieren und Einfügen aus der Zwischenablage.

Obwohl Draw nicht mit speziellen Zeichenprogrammen wie GIMP oder Adobe Photoshop konkur-
rieren kann, kennt es doch auch diverse Funktionen zum Bearbeiten von Bitmap-Grafiken. Diese 
sind in der Symbolleiste Bild zu finden. Details und Beispiele finden Sie in Kapitel 6 „Bilder 
bearbeiten“ im Draw-Handbuch.

Arbeiten mit 3D-Objekten

Auch wenn Draw nicht den Funktionsumfang der spezialisierten Zeichen- und Bildbearbeitungspro-
gramme bietet, so ist es doch möglich, gute 3D-Zeichnungen zu erstellen und diese zu editieren.

Über Form → Umwandeln → In 3D oder In 3D-Rotationskörper oder die entsprechenden 
Untermenüs des Kontextmenüs können Sie vorhandenen Objekte in dreidimensionale überführen.
Abbildung 19 zeigt das Ergebnis für die im rechten Teil von Abbildung 18 ausgewählten Objekte, 
links für „ In 3D“, rechts für den Rotationskörper. Dazu wurden alle drei Objekte markiert und 
gemeinsam umgewandelt; wenn Sie sie einzeln umwandeln, sieht das Ergebnis etwas anders aus,
vor allem die Stapelung im rechten Teil entfällt, alle Objekte sind dann gleich groß.
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Abbildung 19: Dreidimensionale Objekte

Auch diese Objekte können Sie drehen und neigen.

Lesen Sie Kapitel 7 „Arbeiten mit 3D-Objekten“ im Draw-Handbuch für weitere Details.

Grafiken exportieren

Draw speichert eine Grafikdatei im Format *.odg. Wenn Sie einen Teil der Datei oder auch alles in 
einem anderen Format speichern wollen, benutzen Sie Datei → Export. Draw ermöglicht die 
Speicherung des Dokumentes oder des gewählten Ausschnitts (beachten Sie, dass Sie jedes Mal 
wieder Auswahl anklicken müssen) in vielen Bildformaten.

Kommentare zu einer Zeichnung hinzufügen

Sie können zu einer Zeichnung einen oder mehrere Kommentare hinzufügen, ähnlich wie in Writer 
und Calc.

Wählen Sie Einfügen → Kommentar aus der Menüleiste. Ein kleines Rechteck, das Ihre Initialen 
und eine laufende Nummer enthält und das den „Anker“ des Kommentars darstellt, erscheint in der
linken oberen Ecke der Draw-Seite, daneben ein größeres Rechteck zur Eingabe des Kommen-
tars. Draw hat automatisch Ihren Namen und das Datum am Fuß der Textbox eingefügt.

Schreiben oder kopieren Sie Ihren Kommentar in die Textbox. Zusätzlich können Sie einfache 
Formatierungen von Textteilen vornehmen, indem Sie den Text auswählen. Führen sie dazu einen 
Rechtsklick aus und wählen die gewünschte Formatierung aus dem Kontextmenü. Aus diesem 
Menü heraus können Sie auch den aktuell gewählten Kommentar löschen, alle Kommentare 
dieses Autors löschen oder alle Kommentare in dem Dokument löschen.

Sie können den Kommentaranker an jede gewünschte Stelle verschieben, am besten in die Nähe 
des Objektes, auf das Sie sich in dem Kommentar beziehen.

Um die Kommentaranker anzuzeigen oder auszublenden, gehen Sie zu Ansicht → Kommentare.

Unter Extras → Optionen... → Benutzerdaten können Sie den Namen eingeben bzw. ändern, 
der im Autorenfeld in den Kommentaren angezeigt werden soll (Abbildung 13).
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Wenn mehr als eine Person das Dokument bearbeitet, dann wird jedem Autor automatisch eine 
eigene Hintergrundfarbe für die Kommentare zugeordnet.

Abbildung 20: Kommentar zu einer Zeichnung
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